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TLE6 ICT/ENTREP
Quarter 3 — Week 1-2
Buying and Selling of Products
Quarter 3, Week 1-2

Name: Grade Level and Section:

Date: Score:

1. Title: Buying and Selling of Products
2. Learning Competencies:
» produces simple products(TLEIE6-0-a-2)
» Buys and sells products based on needs (TLEIE6-0b-3)
» Sells products based on needs and demands in school and community(TLE6IE-0b-4)
3. Instruction: Read the paragraph carefully and answer the activities that follow.
4. Activities

At the early age, learners are very conscious about new things around them especially in unique and catchy
products found in the market. As facilitator of learning, it is your responsibility to inculcate the fundamental
steps in creating and innovating simple products to produce or even sell. This lesson aims to develop the holistic
knowledge, values and skills of the learners to be an ideal entrepreneur. These will have served as their weapon
to start a simple business despite of the competition on the real world.

Who are sellers?

» are individuals or entities who exchange any type of goods or service in return for payment.

» are the inventors who collect a premium from the buyers in return for taking on the risk associated with
holding a short position in an option.

» are the owners of the store or business establishment.

» offer goods, products or services at a specified amount called the selling price

Who are the buyers?

are the persons who buy the goods or services from the business

are the consumers who make use of the goods to meet their needs and wants and those of their families
are the people who determine what products are they going to buy from stores in catalogues and online
they are the one who purchase a commodity or service

YVVVY
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Activity 1

Match Column A with Column B. Write your answer on a separate sheet of paper.
A B

1. goods a. money equivalent to the quality of the goods paid for

2. buying b. quality of a good or product that is suited to the purpose for it

3. sell will be used

4. producers c.one who buys in large quantity from manufacturers and

5. seller d. one who converts raw materials into finished goods or

6. buyer e. also known as vendor

7. manufacturer f.one who acquires goods in exchange for a sum of money

8. wholesaler g. money earned from a sale

9.right quality h. a business deal between a seller and a buyer

10.right price 1. a plan of action to buy quality goods for a reasonable price

j- also called products or merchandise
Activity 2

Write C if the statement is correct and N if the statement is not. Use a separate sheet of paper.

1. It is a necessity for a business seller to know how to manage money intelligently to ensure and keep the
proper flowing of credits.

2. In business, chances are you won’t succeed if you don’t enjoy what you are doing.

3. Improve marketing strategies and campaigns to reach buyers more effectively.

4. Make prices reasonable to help customers afford what you are selling.

5. Seller usually purchases goods based on personal needs, wants, or interests typically for use, consumption or
even collection.

6. Remember to unlock your monitor screen while away from your computer.

7. Downloading, saving or distributing of any material by copying, storing, printing and showing to other
people are allowable.

8. Information and Communication Technology (ICT) changed the way people live, work, shop and
communicate.

9. In creating a simple products choose some attractive ways on how to get the attention of the buyers.

10. A good seller always believes in success and reluctant to assume any risk.

Activity 3

Read the sentences carefully. Write SELLER if it tells about the seller and write
BUYER if'it tells about the buyer. Write your answers on a sheet of paper.

A A o b o

—
)

— N

»

Farmer

Fruit shake Vendors
Household member
Shopper

Dress maker

Students

Car manufacturer
Automotive parts supplier
Bakeshop owner

. Sari-sari store owner

Closure /What I Have learned
What are the advantage and disadvantages of selling products using productivity tools?

Is new technology relevant in our society or community? Why?
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Reference:

Leonora David-Basbas, Ph.D.

Learning and Living in the 21 Century
www.google.com

Answer Key
Activity 1 Activity 2 Key answers Activity 3
1. j 1. C 1. SELLER
2.1 2. C 2. SELLER
3. a 3. C 3. BUYER
4. g 4. C 4. BUYER
5. e 5. N 5. SELLER
6. f 6. C 6. BUYER
7. d 7. N 7. SELLER
8. ¢ 8. C 8. SELLER
9. b 9. C 9. SELLER
10. h 10.C 10. SELLER
TLE6 ICT/ENTREP
Quarter 3 — Week 3
Posting and Sharing of Wikis and Blogs
Quarter 3, Week 3

Name: Grade Level and Section:

Date: Score:

1. Title: Posting and Sharing of Wikis and Blogs

2. Learning Competencies:

» Posts and shares materials on wikis in a safe and responsible manner (TLEIE6-0Oc-5)
» Posts and shares materials on blogs in a safe and responsible manner (TLEIE6-0c-6)
3. Instruction: Read the paragraph carefully and answer the activities
4. Activities

Safe and Responsible Use of ICT

Information and Communication Technology or ICT facilities benefit a lot of people from different institutions,
corporations, and even in the education sector. This includes the use of wireless network, internet, email,
computer, tablet laptop and any electronic devices. For efficiency and safety use of ICT, the following
obligations and responsibilities must be observed.

1.

When using social media account, log on only using your own username and password. Keep your password
and avoid sharing it to anyone. Remember to log out on any devices used after using.

When joining in an audio and video conference, be polite and always use the appropriate language. Do not
access, create, store or distribute files that may offend or indecent or may cause harm to anyone.

Never meet anyone that you have recently acquainted online. As your parents or trusted adult for assistance.

Avoid involvement of any online activities which might put you or anyone at risk. Use ICT for school
related activities only. Attempt to access to any inappropriate age restricted or objectionable website are not
allowed. This might put you in danger.

Used of online access MUST be with parent’s guidance.

Downloading, saving or distributing of any material by copying, storing, printing, and showing to other
people are NOT ALLOWED unless it is copyright free.

Use social networking and social media appropriately. Be careful about the places you go online and focus
always on learning task.

Ask your parents or guardians permission in using personal information such as names, addresses, email,
phone numbers and others.
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What 1s a wiki?

» This is a website that is collaborative in nature. It means that a user or anyone using this website can
participate or work jointly with a creator or author of a written work in a wiki. To work jointly means one
can add, modify, edit, delete, revise, or update some of the content of the work of the creator or author of
that work.

» A wiki uses a software in the name of wiki engine or wiki application.

A\

A wiki allows user to use a web browser to revise or update part of the content of the work of an author or
writer without any restriction. However, as a responsible user, you should cite your reliable sources from
which the information you have added in the website can be located.

» The term” wiki” was originally named Wiki wiki Web. This was introduced by Ward Cunningham in 1995.
This word came from Hawaiian” Wiki Wiki” which means fast or swift.
Examples of Wikis

a. Wikipedia- this is the most popular and most used website. It contains information of practically all kinds of
topics or subjects from arts to sciences; reality to fiction; from history to literature to production and
manufacturing and anything under the sun. the Wikipedia can serve as an online version of an encyclopedia.
To locate this website, go to http://wikipedia.org

b. Library Blog Wiki- this wiki deals with the way blogs and wikis are used.
Charles Sturt Library Wiki-this wiki is used by students and staff of Charles Sturt Library

d. Tolkien Wiki-this wiki is exclusive for the readers of the novels of JRR Tolkien. This website can be access
at http://www.thetolkienwiki.org/wiki.cgi.

Steps in Using Wiki

1. Open your browser. Some examples are Google Chrome, Internet Explorer and Mozilla Firefox

2. Type in the content that you want to look for in wiki in the search bar. Example: historical events like World
War II.

3. Select the wiki page from the results or findings from your previous search.

4. You will be directed to the website.

5. From there, you will find information about the topic you are searching for.

6. If the website does not contain the information you need, click the Back button and select another search
results.

Activity 1

Find the keywords in any order related to posting and sharing from Wiki sites. Write your answers on a separate
sheet of paper. (10 WORDS).
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Activity 2
Write TRUE if the statement is true and FALSE if the statement is false. Use a separate sheet of paper.
1. Share your password to anyone.

2. When joining in an audio and video conference be polite and always use appropriate language.
3. Meet anyone that you have recently acquainted online.
4. Post anything you like in social media.
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Share your personal information to anybody.

Ask permission from any person such as parents or guardians with regards to personal information.
Use social networking and social media inappropriately.

Safe and responsible use of ICT is very important.

Lo aw

Download or distribute any materials by copying is allowed.
10. Don’t search or browse website which are not appropriate for your age.

What is Blogs?

» A blog is conceptually a linear format, where articles are presented in a reverse chronological order
(youngest first) by default, usually written by a single or few people, and seldom edited after posting.

» Blogs and journals or diary entries are almost alike in format. It is written in an informal conversational style
typically run by an individual or small group.

Activity 3

Identify what kind of blog is in the picture. Choose your answer in the box below.

(5 points each correct answer). Use a separate sheet of paper.

s e
AP ]

 FASHION

SN EEF I ORE N W N UL aE- O .
T AT T v o
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i WU T 7
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Travel blog Food blog Beauty blog Fashion blog
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How to start a blog?

1. Choose where to create and host your blog. Some of the popular blog creation sites on the web are Blogger,
WordPress, Blog.com and many more.

2. Startablog at Blogger.com. log in to your existing google account or click on the red “Sign Up” button on
the upper right corner and register for a google account if you still don’t have one.

3. Click the “New Blog” button.

4. Create a new blog. Fill in your blog name and desired blog address and click the orange “Create Blog”
button. You may choose a template from the options on the screen.

5. Select the “Start blogging” link and enter your title and your text. Click “Publish”

Activity 4

Arrange the following steps in starting a blog. Write your answers in a separate of paper. Use numbers 1-5. (2
points each correct answer.)

a. click the “New Blog” button

b. start a blog at Blogger.com.

c. choose where to create and host your blog.

d. select the “Start Blogging” link and enter your title and your text.

e. create a new blog.

Steps on how to post a blog

1.

NN R WD

Point browser to http://wordpress.com and click” Get Started “ link.

Find a domain by filling in the online form.

Click the “Create Blog” at the bottom page and wait for your confirmation email.

Click the link and sign into WordPress using your username and password.

Select a theme for your blog.

Click the “Settings” tab to decide whether you want your blog to be private or public.

Click “Start a Post” button in the “Blog Posts™ tab and enter your title and body of your blogs.
Click “Publish” tab.

Let’s explore!

Exercise 1: If you have an internet connections and gadgets to be used such as computers, desktops, laptops,
or netbook you can explore this activity and if you don’t have an internet connections and gadgets just skip
this activity.

Closure /What I Have learned

1. What are the safety tips on responsible use of social media?
2. What is the difference between Wiki and Blogs
Reference:

Leonora David-Basbas, Ph.D.
Learning and Living in the 21 Century
www.google.com

Activity 1 Activity 2 Key answers Activity 3 Key answer
1. Software 1. FALSE 1. FASHION BLOG
2. Internet 2. TRUE 2. FOOD BLOG
3. Browser 3. FALSE 3. TRAVEL BLOG
4. Button 4. FALSE 4. BEAUTY BLOG
5. Posting 5. FALSE
6. Website 6. TRUE Activity 4
7. Wiki 7. FALSE a 3
8. Search 8. TRUE b 2
0. Sharing 0. FALSE c 1
10. Google 10. TRUE d 5
e 4
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LEARNERS ACTIVITY SHEET IN TLE6 ICT/ENTREP
Quarter 3, Week 4

Name: Grade Level and Section:
Date: Score:

1. Title: Video and Audio Conferencing
2. Learning Competencies:
» Participates in video and audio conferences in a safe and responsible manner (TLEIE6-0d-7)

(98]

Instruction: Read the paragraph carefully and answer the activities
4. Activities

Communicating and collaborating Using ICT

Communicating and collaborating using ICT is possible through audio and video conferencing. Audio and video
conferencing allow group of people to connect distantly over a network and conduct a meeting, lecture and
discussion using multiple devices such as laptops, desktops, tablets, and cellphones.

Audio and video conferencing allows productivity and motivates a participative learning style. It also promotes
highest principle in advancing education. It also motivates students to learn more comfortable with the medium
compared to traditional class. This can be used for group work where they will meet through a conference bridge
to a schedule times in completing their assigned task.

Gadgets commonly used in Audio and Video Conferencing
1. HD Video camera
» This is used to be clearly seen during conferencing

2. Tablet
» A mobile device that has the capacity to download video calling applications

3. USB headset and headphones with a mute button
» This is used to optimize audio input and output. A pair of headphones with a mute button to the
device is used for smartphone or tablet.

4. Video conferencing application for mobile devices
» This is an application that supports multi-person video and sharing content for presentations.

5. Web conferencing software
» Used to incorporate the whole meeting together with the numerous conference call attendees.

6. Video-conferencing screen
» This is a monitor or screen which is vital for easy communication and for viewing between you and
you’re talking to.

7. 3 G or mobile WI-FI
» Used to have an internet access or to secure internet connection through Bluetooth, WI-FI or USB
port.

8. Mobile file sharing
» This is used to have an access to files edit and send files if you are in a place accessing the local
servers and network. This is necessary to maintain workflow.
Activity 1.
Identify what kind of gadgets used in audio and video conferencing. Use a separate sheet of paper.
1. This is necessary to maintain workflow.
2. This is a monitor or screen which is vital for easy communication.
3. Used to have an internet connection.
4. This is used to be clearly seen during conferencing.
5. This is used to optimize audio input and output.
6. Used to incorporate the whole meeting together with the numerous conference call attendees.
7. A mobile device that has the capacity to download video calling applications.
8. This is an application that supports multi-person video and sharing content.
9. It has built in microphone with headphone.
10. This is used to have an access on files sharing and editing.
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Activity 2

Identify what kind of gadgets used in video and audio-conferencing using pictures below. Use a separate sheet of
papers. (2points each)

l. 2.

e

4. 5.
ﬁ D
Activity 3
Match column A to B. Use a separate sheet of paper.
1. Tablet a.it is the input device used to speak
2. Web conferencing software b. necessary to maintain workflow
3. Video conferencing application c. this is a monitor or a screen which is vital for easy communication
4. HD Video camera d. used to have an internet access
5. USB headset e. used to be clearly seen during conferencing
6. Video conferencing screen f. application that supports multi person video
7. Mobile file sharing g. used to optimize audio input and output
8. 3G or mobile Wi-Fi h. a mobile device that has the capacity to download video calling app...
9. Scanner 1. used to incorporate the whole meeting
10. Microphone J- used to scan pictures and store in computer

Steps on how to participate in Audio and Video Conferencing
Open your data or internet connection.

Click “S” to be able to navigate to the skype download page.
Select the version of Skype to download.

Click “Get Skype for Windows Desktop”

Install Skype with your devices’ chosen method of installation.

Start skype and sign-in using your Skype account.

NS kD=

Select and invite online contact from your contact list. To add contacts, select and click “Add Contact” from
the upper right of your contact list and enter a Skype username.

>

Click “Status” to online mode.

9. Select and click “Video Call” to start a video call. For video conference, click the “ “sign and “Add
people” to add more Skype contacts.

10. Have fun and enjoy your conversation.
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Activity 4
Arrange the following steps in participating Audio and Video conferencing.

Use a separate sheet of paper. Use numbers 1-10.

a. Install Skype with your devices’ chosen method of installation.
b. Click “Status” to online mode.
c. Start skype and sign-in using your Skype account
d. Click “S” to be able to navigate to the skype download page
e. Open your data or internet connection.
f. Select the version of Skype to download
g. Click “Get Skype for Windows Desktop”
h. Select and invite online contact from your contact list.
i. have fun and enjoy
J. Select and click “Video Call” to start a video call
5. Closure /What I Have learned

Try this one!

If you have an internet connection and gadgets to be used, you can explore and discover the steps in
participating Audio and Video conferencing.

Note: If no internet connection and gadgets just skip this exercise.

Reference:

Leonora David-Basbas, Ph.D.

Learning and Living in the 21% Century
www.google.com

Answer Key
Activity 1 2. Video conferencing application 9. j
1. Mobile file sharing 3. Laptop 10. a
2. Video conferencing screen 4. Headphone with microphone
3. 3G or MOBILE Wi-fi 5. HD Video camera Activity 4
4. HD video camera I. 5
5. USB headset Activity 3 2. 8
6. Web conferencing software I. h 3. 6
7. Tablet 2.1 4. 2
8. Video conferencing application 3. f 5.1
9. USB Headset 4. e 6. 3
10. Mobile file sharing 5. ¢ 7. 4
6. ¢ 8. 7
Activity 2 7. b 9. 10
1. Tablet 8. d

Quarter 3, Week 5

Name: Grade Level and Section:

Date: Score:

1. Title: Online Survey Form

2. Learning Competencies:
» Creates an online survey form (TLEIE6-0e-9)
» Processes online survey data (TLEIE6-0f-11)
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3. Instruction: Read the paragraph carefully and answer the activities
4. Activities
Gathering and Organizing Information Using ICT

The use of internet is a great and outstanding communication channel. It is accessible, convenient and flexible to
use. Internet allows computers to connect and exchange information globally. It operates and give a 24/7 service
that helps corporations do their business efficiently. It is less expensive to publish information on the internet
compared to the traditional methods of disseminating and distributing information. Web allows companies and
individuals to advertise their products and services. Buyers are able to check and look up on a product
specification and explore information about the product before purchasing. Web is ideal to obtain customers
feedback on a product or services which corresponds to customer’s satisfaction and service quality. Through
media capabilities, World Wide Web allows business to provide timely information available immediately to the
buyers. However, using internet would also be unsafe in some ways. Though it is an excellent tool for doing
research, some materials may have not been checked and evaluated critically and thoroughly by professionals.
Some maybe outdated. Since it has no quality control in any information, anyone can publish anything on the
internet as long as you have web and a server. Therefore, users need to be careful and learn to use searching
skills effectively in order to have an extensive and successful research.

Creating and Disseminating an Online Survey

A survey is a method of gathering information through a brief interview or discussion with individuals about a
specific topic. Nowadays, online method is used which is easy and inexpensive and is often used compared to
the traditional way of conducting surveys which is somewhat slow and costly.

Activity 1

Write A if the statement is Advantage and D if the statement is Disadvantage.

Information and data are gathered and processed automatically.

Results are accessible and ready at any time.

Needs more budget for internet connection.

More convenient for the respondents and participants.

Not all students and parents have the gadgets to be used.

Can easily be styled and lay out questionnaires.

Allows researcher to be more selective on participants that match only on the target profile in completing the
survey.

8. Some parents don’t have enough money to sustain internet loads.

9. Questions can be modified or skipped depending on the answer from the preceding questions.
10. Not all parents and students have an electric source.

Nk W=

Survey results can be automatically updated through database and can also be used in keeping and pulse
customer’s opinions and needs. Data gathered is stored automatically and can be analyzed right away. Tables
and graphs can be used to make visual representations of the gathered data to evaluate results.In an online survey
system, participants who sign up for the study will be asked and directly answer and complete the survey form
and will be credit automatically.

Activity 2

Find words in the word puzzle which are related to online survey forms. Write your answer on a separate sheet
of paper. (In any order)
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Activity 3
Write True if the statement id true and False if the statement is false. Use a separate sheet of paper.

i S I e

S

Organize questions according to topic.

Locate sensitive and personal questions at the last part of the questionnaire.

Use non attractive designs in online survey forms

Stimulate participant’s memory by adding videos or images.

Make a difficult and hard to answer questions.

Inspire trust and assure the participants that personal details will be kept safe and will be protected.
Have a trial test to few people of your survey.

Collect and gather participant’s responses.

Don’t evaluate the participant’s responses.

. Prepare and create the list of questions.

Closure /What I Have learned

Try this one!

If you have an internet connection and gadgets to be used, explore and discover ideas on how to create an
online survey form through www.youtube.com. After viewing the steps on how to create, try to follow the
steps and make your own online survey form.

Note: If no internet connection and gadgets just skip this exercise.

Reference:

Leonora David-Basbas, Ph.D.

Learning and Living in the 21* Century
www.google.com

Answer Key
Activity 1

1. A

2. A

3. D

4. A

5. D

6. A

7. A

8. D

9. A

10.D

Quarter 3, Week 6

Name: Grade Level and Section:
Date: Score:
1. Title: Electronic Spreadsheet
2. Learning Competencies:

» Uses functions and formulas in an electronic spreadsheet tool to perform advanced calculations on

numerical data (TLEIE6-0f-12)

3. Instruction: Read the paragraph carefully and answer the activities

» Performing Advance Calculations Using Electronic Spreadsheet
4. Activities

The most used electronic spreadsheet nowadays is the Microsoft Excel. This program is usually used in
processing data containing numbers and records of activities using graphs and charts. This is used in making
statistical analysis, creating formula and database.
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Spreadsheet always assumes that everything that starts with” =" is a formula so you must be careful in using it.
Like a calculator, a spreadsheet uses symbols of “basic math functions” which can be in calculating numerical
data.

Using Functions and Formulas in Calculating Numerical Data

In an Excel Spreadsheet, formulas are the real command. It uses standard mathematical symbols to operate on a
cell address or numbers. It can be a combination of values (numbers or cell references) and mathematical
operations into an algebraic expression. These symbols include:

+ for addition

-for subtraction

*for multiplication

/ for division

% for percentage

~ for exponentiation (power)

You may use parentheses and decimal points in addition where needed. See the example below:

=sum(B1+C1+D1+E1) can also be written as = B1+C1+D1+E1

To construct a formula:

e Always start the formula with an equal sign” =" followed by (“sum”) or else Excel will just consider the
entry as text

e Start writing the formula in the cell by clicking in that cell. After entering the formula, type “Enter” or “Tab”
to move to the next cell.

e Formulas with numbers will give results that will not change as, =sum (120*5) always give an answer of 600

e Formulas that contain cell references give a result that may change depending on the data written in the cell
as, =sum (B2+C2).

Page Layout Farmulas Drata

Clipboard = Font Aligmm

SUM - > v —sumM{Dz+C2)|
A B C D (=

1
2 | Quiz 1 | iz 2 |Final Exam Total
z | 29 a1 [=sum(B2+C2)|
4

In this case, excel will give the total of 180 since B2 is 89 and C2 is 91. The total will automatically change if
you will enter another value in the cells B2 and C2.
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Page Layout Formulas Data Rewview View
A Cut
i Copy -
Clipboard [l Fant Alignment
SUM iy X oo | SSUMIB2C2)
A B | € | b E F
1
2 |_Qui11 |_(1ui22 IFinal Exam Total
3 | 83 86 =SUM (B2+C7)
4
5 1
Adding and Subtracting

In the given data below, calculate the total projects submitted by each group and class using an electronic
spreadsheet.

-ﬂ" A - Fa FY
“4."“-. I"r :'-:r:l'-\..11-a'n|n|f-| o r u - - = =
£
A B T

1 Group Coin Purse Wallet

= 1 B (=3

= 1 =2 F

<} 1l = ] =1

5 W = ] =

6 AV a8 7

Create a copy of the given data in the spreadsheet then move to first row to start.

1. Enter “=SUM” and select the cell you want to add. Note how the formula written on the cell reference.
Remember that each formula always starts with “=sum”.

A | B C D
1 Group  CoinPurse Wallet  Total Project Submitted
2| + | 8 | 6 =SUM(E2 |
3 [} 8 7 R S
4 11} g g
] v 9 8
& v 8 7
7
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e = oW B W P =

o
I
i
v
v

Humbie

D

Group |Coin Purse| Wallet

Total Project Submitted

c W Ww o

6

=] 00 W =J

=SUM(B2+C2|

sk msenbier 1, |ormiberd[ -

3. Press “Enter” or “tab” and the formula will disappear and will be replaced by the value which is the

ansSwer.

= o N B W=

¥ Format Pairaer

Clpooand

Page Layout Fommules
n A A
Iy - Sel-|==
B i
.Cm‘n Purse .Waflet
B b
8 7
9 9
9 3
8 7

& -- Wrap Te iraen

=35 ElMugeBiCeoer » EF- 05 v 8 0
D

Total Project Submitted
14

4. Your formula can be written individually but you can also “cut and paste” it or just “drag” across a series

of cells.

5. To get the sum of the two rows, copy the formula using ctrl+c and paste it in to the cell below using

ctrl+v.

6. To update the “total” column, you may also alternatively click on the lower right corner of the cell and

drag the formula down to the bottom of the column.

B. To subtract values using spreadsheet, its exactly the same, just use” — “instead of “+”’.
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Multiplying and Dividing

Here’s how to multiply and divide values using the spreadsheet.

Problem: 25% of the 1,000 Grade VI students are boys. How many are boys?
Compute the number of boys by using this formula:

Number of students in Grade VI x (25+100)

In excel, it will be expressed simply by:

LI p W K =5 U M LO00™ 253 ‘
_ A B €
1 Group Number of Students Actual Number of Boys
2 v 1,000 =SUM(1000*25% ﬂ
3 | ¥ e et e
4
3
6
? |
8 !

Page layout Foemralas

e "' E' Calibr 0 e == % | S Ted Berviral

Toe -l-'i;:::,.;::....u. BIU- G- &-b- === 55 Evegeatne - B-%0r 49
A B C

1 Double-click to add header

2 Group Number of Students Actual Number of Boys

3 v 1,000 250

4

Now let’s try these:

A. Jessica gota 95% in a 120 item in a math test. How many items did she answer correctly” formula in the
spreadsheet will be expressed as:

—sum (95*120/100)

B. Compute the rate of tax and the total amount to be paid based on the given data. Rate of tax formula=
Gross Amount divided by 1.12 multiplied to %
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Office supplies Php 27,758.00
Office supplies Php 1,410.00
Therefore, formula in the spreadsheet will be expressed as;

To solve for 1% rate of tax of office supplies =sum (B3 / 1.12 * 0.01)
To solve for 5% rate of tax of office supplies =sum (B3 / 1.12 * 0.05)
To solve for 2% rate of tax of other supplies =sum (B4 / 1.12 * (0.02)
To solve for 5% rate of tax of other supplies =sum (B4 /1.12 * 0.05)

To solve for the total tax of other supplies =sum (D5 + G5)

A B C D E F G
1 Particulars Gross Amount Rate of Tax Total
2 1%_ 2%_ 5% 5%
3 Office Supplies| 27,758 247.84 11,239.20 1, 487.04
4 Other Supplies| 1,410.00 |25.18| 62.95  B88.13
5 Total 247.84 25.18|1,239.20 1,302.15- 1,575.17
E !
-

—

Sample formulas

1. This formula shows to multiply 250 by 6, as resulting to 1500
=sum (250 * 6)

2. This shows adding the values in cells D2 and E2:
=sum (D2 + E2)

3. This subtracts the value in the cell C3 from the value in cell C2 and then multiplies the result by the value in
cell C4.
=sum (C2- C3) * C4

4. This formula uses the “ SUM” function to ask the value in the range C1: C12)
=sum (C1: C12)

5. This one compares the value in cell Al and value in cell B1. if the values in the two cells are identical, then
the formula returns TRUE otherwise, it returns FALSE.
=Al =Bl

Activity 1

Arrange the scrambled letters to form a word about Microsoft Excel.

1. cexel

2. ormfuasl

3. lavues

4. ums

5. evagare

6. rwos

7. owrkseeth

8. atb

9. ecll

10. orfatm
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Activity 2

Write TRUE if the statement is true and FALSE if the statement is false.
The symbol for addition is +.

1. The symbol for multiplication is /.

The symbol for percentage is %

When using formula in excel. Always start with symbol “ ="
In excel spreadsheet, formulas are not real command.

The symbol for subtraction is *.

After typing the sign =, add follows.

Excel usually used in processing data containing numbers and other records of activities.
Numbers or cell reference is the same.

9. Excel helps computation complicated and difficult.

S A

Activity 3

Put (V) if it shows correct way of using formulas in Excel and (X) if not. Use a separate sheet of paper.
I. =sum (B4 + BS)
2. /add (C1+ DI1)
3. =sum (25 * 1000/100)
4. >subtract (G3 — G4)
5. =sum (D5 + H5)
6. =sum (& - %)
7. =sum (C2 -C3)*C4
8. €=add (A1 & Bl)

9. =sum (Al: El)

10. *=add (T% + V&)

Activity 4
Matching type: Match Column A to Column B. Use a separate sheet of paper.
Write the letter only.

1. Spreiisheet a. an electronic tool used for c]c?mputing large quantities
2. Electronic Spreadsheet ~ of numbers
3. Formula b. used as guide/rule to perform calculations
4. Multiplication c. font size, style, alignment, etc
5. Division d. a document for organizing, analyzing and
6. Equal sign calculating data using graph paper and pencil
7. Basic formatting tools e. where data/information in the spread sheet are placed
8. Cells f. elements found in a table
9. Rows and columns g. starting sign of a basic Excel Formula
10. Autosum h. forward slash(/)
1. Asterisk (*)
i =
6. Closure
Try this one!

Note: 1If you have laptop or netbook, desktop or any device which can be used during hands-on activity of
Microsoft excel, then try this activity. If no device or gadgets just skip this activity.

1. Mae sold 75% of the 300 chicken in his backyard. How many chickens did he sell?

2. Zhaniah won P25, 000.00 in a lottery. To share his luck, he gave 5% of'it to his brother. How much did Gen
give to his brother?

3. A farmer sold 45 cavans of rice at P 900/cavan. How much money did he receive?
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Reference:
Leonora David-Basbas, Ph.D.
Learning and Living in the 21 Century

Answer Key

Activity 1 4. TRUE 8. X
1. Excel 5. FALSE 9.
2. Formulas 6. FALSE 10. X
3. Values 7. FALSE
4. Sum 8. TRUE Activity 4
5. Average 9. TRUE 1. d
6. Rows 10. FALSE 2. a
7. Worksheet 3. f
8. Tab Activity 3 4. 1
9. Cell 1. 5. h
10. Format 2. X 6. g

3. 7. ¢

Activity 2 4. X 8. ¢
1. TRUE 5. 9. b
2. FALSE 6. X 10.
3. TRUE 7.

Quarter 3, Week 7
Name: Grade Level and Section:
Date: Score:

1. Title: Audio-Video Conferencing Tools and E-Groups

2. Learning Competencies

» uses audio and video conferencing tools to share ideas and work with others online (TLEIE6-0g-13)
» uses an e-group to share ideas and work with others (TLEIE6-Oh-14)

Instruction: Read the paragraph carefully and answer the activities

4. Activities

[98)

What is audio-video conferencing?

Audio-video conferencing is a method of communication between two or more people with personal computers
who are all connected online through the internet. In this method both parties can talk, see, and hear each other
in their personal computers using audio-video conferencing tools.

Requirements for Audio-video conferencing

Computer technology is important in using an audio-video conferencing tool or any type of communication tool
online. One has to be prepared with a few devices in order for two or more people to communicate on the
internet. One important device is the Personal Computer or PC. The personal computer is the most important
technology in operating any software and connecting to the internet. This device helps connect one person’s
computer to person’s computer using different audio-video conferencing tools found on the internet.

The second important factor in using an audio-video conferencing tools is the internet access. Without an access
to the Worldwide Web, a personal computer would be useless in communicating online. Only a fast internet
access can support a successful and productive online audio-video conversation between two people. Broadband
is a type of internet connection that is widely used today because it is the fastest and most popular method to
connect online. This type of internet connection uses cable or telephone lines or radio signal to connect to the
personal computer.

Other important attachments are audio-video devices that must be connected to the personal computers such as
speakers or headsets to enable a person to hear the other person online. Another one is the microphone to enable
a person to record audio, as well as speak to the other person without using text messages. Finally, a web camera
or webcam is required to enable video recording and to be able to see the other person whom one is
communicating with through the screen or monitor of the personal computer.
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What are audio-video conferencing tools?
These are different online tools consisting of software where one can hold audio-video conferencing
simultaneously in different locations and with different e-groups participating.

One on one Conferencing Applications
Skype

> Is an IP telephone service provider that provides free calling between subscribers and low-
cost calling to people who don’t use the service. Furthermore, Skype supports file transfers,
texting, video chat and video conferencing. The application is available for desktop
computers, notebook and tablet computers and other mobile devices including mobile
phones.

» Isaninstant messaging and voice over IP(VoIP) app for smartphones settled by Viber media.
In addition to messaging, they allow the users to send images, video, and audio media
messages.

> Is a mobile text and voice messaging communication service established by Tencent in
China, first released in January 2011. It is one of the largest impartial messaging apps by
monthly active users.

Facebook

> Is an online social networking website where people can construct profiles, share information
such as photos and videos about themselves, and respond or link to the information posted by
others. Facebook is also one of the largest social networks that works to interact with other
people.

Examples of Audio-video conferencing tools

1. Gizmo and Skype (both cross-platforms) enable the users to speak to other Gizmo/Skype users free of charge
or pay a fee to make calls to landlines using the computer.

2. IVisit(cross-platforms), Ichat (Mac only), NetMeeting (Windows only)- these are free video conferencing
softwares.

3. Breeze-this can be used for video conferencing but it can be used for multiple sites or locations with a big
group participating.

4. Other examples of softwares in audio-video conferencing can be seen in Wikipedia.

Today, it is possible for video conferencing organizers to do a live video streaming of a single display video
conference system. These organizers can use for example, Epiphan broadcaster hardware streaming product.
This product allows broadcasting of video conference events to people from various places. This is done by
intercepting, encoding and then streaming the video conference system.

VGA (Video Graphics Array), DIV (Digital Visual Interface), or HDMI (High definition Multimedia Interface),
video output. In this example no software is needed to be installed.
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These products are effective means of delivering different audio-video conference streams through the network.
This capacity enables a meeting holder to transmit live video streaming of a video conference.

E-groups

E-group consists of online users who signed up for membership on an email list management website. This site
allows members to create their own mailing lists. These members also have shared calendars, file space, group
chat, and a simple database.

E-groups can share and work with one another on certain issues, topics or themes using audio-video
conferencing. They can also participate in other group conferences on topics of interests to which they will
benefit. This sharing is particularly helpful in the fields of business, education, medicine, and others which work
on a common vision, mission, goal or advocacy.

What is an e-group?

» A group (often termed as community, e-group or club) is a feature in many social network services which
admits users to create, post, comment to, and read from their own interest and niche-specific forums, other
within the realm of virtual communities. E-groups, which may consent for open or closed access, invitation
and or/ joining by other users outside the group, are formed to offer mini-networks within the larger, more
diverse social network service.

Different e-group applications on the Internet

1. Google + Communities

» One of the greatest benefits this particular social media group offers business owners is the ability to
generate business authority and greater branding by allowing them to engage in these communities using
their own business page profile.

2. Facebook Groups

» As the largest social media network, participating in Facebook groups will be your business’ greatest
advantage. You can join groups related to your industry or business and engage members, many of which
maybe viable potential customers interested in your products or services. You can also create and build your
own community through Facebook Groups and attract highly targeted audiences, many of whom may
already be actively searching for what you might offer them.

Using an e-group to communicate with others

Sending text messages

1. Sign in to Skype

2. Click the person you want to contact by going to the People tab, looking for a current conversation in Recent
or by using the search feature.

After picking a contact, tap the plus icon

Select Send via SMS

Enter your message you want to send.

Tap the send button.

ANl

If you can’t choose Send via SMS, it means that person you want to contact doesn’t have available phone
number accompanying his/her account.

Sending different multimedia files

Skype is great for sharing your files such as photos, documents, or videos with your friends who are on Skype.

1. Sign in to Skype

2. Click the person, or group you want to contact by selecting the People tab, looking for a current conversation
in Recent, or by searching the name.

3. Select the contact and click the icon in the text box of what you’d like to send or the action you want to take:

Switch to your native keyboard

Emoticon

Moji

File

Photo

Take a new photo

Record a video message

Location

rTommoaws
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If you’re sending a file, select the button you’d like to use to find or create the file (such as file manager or voice
recorder).

Click the file and it will be sent automatically.

Receiving Files
If your contact sends you something, it will appear in your chat.

To view a file, click it in the conversation window and it will open in the app automatically. Skype will still be
running in the background.

TEpm a wreewiig s ben n
AW e

Activity 1.
Match Column A to Column B. Write the letter only in a separate sheet of paper.
A B
1. Internet a. a device/program used to locate different websites
2. Tools b. the interconnection of computers to access
3. Conference different websites
4. Skype c. a meeting to discuss a topic
5. Internet Browser d. they are software accessed
6. Viber e. moving visual images usually recorded digitally
7. Audio or by a videotape
8. Video f. sound waves that can be heard by the human ears
9. Facebook g.an [P telephone service provider that provides free
10. Google calling
h. an instant messaging and Voice over IP app
i. a website that provides a wide range of information about places, things,
people, and events
j. a website to get in touch with friends and relatives
Activity 2

Write the letter of the correct names of each application which can be found in the internet. Choose your answers
in the box. Use a separate sheet of paper.

1°2M 3'E4.& 5.%
6. 7. @ 8. E 9. 1| 10 g

a. sheet b. calendar c. slides d.skype e.drive

f. classroom g. hangouts h. Gmail 1. docs j. forms

Activity 3
Write the correct names of each application which can be found in the internet. Choose your answers in the box.
Use a separate sheet of paper.
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R

6. @ 7. 8. {Ej’ 9. ﬁ 10. E

a. viber b. expedition c. video conference  d. google meet e. Messenger

f. google maps g.chrome h. Goto Meeting 1. groups j. G Suite for Education

5. Closure

Remember this!

» Audio-video conferencing is a method of communicating between two persons with personal computers who
are both connected online through the internet.

» Audio-video conferencing tools are a wide range of online tools using different software from the simple
(Gizmo, Skype) to the most complicated (Polycom).

» There are steps to be followed in organizing audio-video conferencing.

Here are some applications for sharing information to other people.

Reference:

Leonora David-Basbas, Ph.D.

Learning and Living in the 21* Century
www.google.com

Answer Key

Activity 1 Activity 2 Activity 3
I. b l. g I. h
2. d 2. h 2. ¢
3. ¢ 3. f 3. d
4. ¢ 4. e 4. f
5. a 5.1 5. ¢
6. h 6. a 6. a
7. f 7. b 7. e
8. e 8. ] 8. b
9. ] 9. ¢ 9. ]
10.1 10.d
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Quarter 3, Week 8

Name: Grade Level and Section:

Date: Score:

1. Title: PowerPoint Presentation/ Slide Presentation
2. Learning Competencies:

» uses the advanced features of a slide presentation tool to create a multimedia presentation with text,
graphics, and photos; hyperlinked elements; animation; and embedded audio and/or video (TLEIE-0i-15)

» uses the moviemaking software to create a multimedia presentation (TLEIE6-0j-16)
3. Instruction: Read the paragraph carefully and answer the activities
4. Activities
Creating a Multimedia Knowledge Product

The combination of text, video, animated graphics and sound delivered to you through electronic means
MULTIMEDIA. For entertainment, learning and even in research, the use of multimedia appeals to us. As
technology develops, we have seen how both presentation and multimedia merge.

In school, it has been observed that the use of multimedia makes learning entertaining and interesting.

The Microsoft PowerPoint is one of the programs used in creating a multimedia through slide presentations
containing documents, pictures, charts and many others. This program is commonly used when presenting
reports to an audience in offices and schools.

Pull Down Menus of PowerPoint

Similar to other programs in Microsoft windows, the MS PowerPoint has also the same pull down menus that of
MS Word and MS Excel. Below are the common menus of the MS PowerPoint.

File

» Commands such as save, save as, print preview, and print are found in this menu.

Edit

» This is where you can find undo, , redo, , cut, copy, and paste commands.
View

» Used to see what you have done in the slides where you can view your presentation.
Insert

» This is used to insert new slides to your presentation. This is also used when inserting sounds, graphs,
pictures, and figures in the presentation.

Format
» Used to change font type, colors, line spacing and alignment of text.

Tools
» This is commonly used checking the spelling of your text.

Slide shows
» This is used to view your slides and improve the presentation using different animation effects.

Windows
» This is used when you want to check other presentation that is open.

Help
» This will assist you if you have problems and difficulties in developing your presentation using PowerPoint
instructional assistant.

Using Animation Effects

Animation effects can also be used to make the presentation attractive. Click on the slide show from the task
pane and click the animation schemes. This will show a miniature window where you can see samples of
animation effects. Explore and choose an animation effect. Click on this to apply to your presentation.
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MS PowerPoint

Applying Animation

1. Display the slide in normal view to see what needs to be animated.
2. Click the down arrow in the animation group.
3. From the options, select the type of text you want to use,
¢ No animation- all animation effects will be removed
e Fade- this will cause object to become lighter or fade in
e Wipe Fly in- the selected object will fly into a position from the bottom of the slide
e Wipe- object will appear slowly from the bottom of the selected object to the top.

4. When working with text, select in any of these options:
e To apply the selected animation to the entire text placeholder one at a time, click “All At Once”
e Toapply the selected animation to the first paragraph level one at a time, click “By 1*' Level Paragraph”

9]

Click “Preview” to see the animation you made on the selected slide.

>

Click “Show” to see and play the presentation you made.

MS PowerPoint

To Add Custom Animation

1. Display the slide in a normal view.

2. Select the object or text that needs to be animated.

3. Click “ Custom Animation” on the animation tab.

4. Click “Add Effect” and click a choice.

5. Click “Change” button if you want to replace other effect.

6. To delete an animation made, click “Remove”

7. To modify, click “Start” and select when the animation you want to be started.
8. To see the effects of animation made, click the “Play | » riyFem | button.

9. To see the presentation, click the “Slide Show” T button.

Changing the Order of Animation a
1. From the task pane, click the effect name.

2. To move the effects, click “Re-Order” button up or down.

Using the effect Option for Animation
1. Click the effect down arrow in the task pane.
2. Click “Effect Options”
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Click the “Effect” tab and select an option for that effect

Click the “Direction down arrow. Choose how animation will travel across the slide.
To choose sound effect fro the animation, click the “Sound” down arrow.

To choose how the line of text will be animated, click “Animate Text”

Close the effect tab by clicking “Ok”

Inserting Sounds
To insert sounds from the clip Organizer

1.

NN R WD

©

AN

Display the slide in a normal view and select the slide you wanted to have a sound effect.

Click the “Insert” tab

Click the “Sound” down arrow from the “Media Clips” group.

Click the “Sound” from “Clip Organizer” and the clip art will be displayed.

Type the subject under “Search for” on the clip art task pane.

Click the sources you want to search in the “Search In” drop-down list box.

Select sounds in the “Research Should Be” drop down list box. Click the (+) sign to display the sound.
Click “Go”. To hear the sound, click the down arrow on the side of a thumbnail and click
“Preview”/Properties. As the dialog box appears, the sound will play.

Click “Play” to hear the sound again and click “Close” if satisfied with the sound.

. Double click the “thumbnail” of the sound file you want to insert the sound on the “Clip Art” tsk pane. A

message will be displayed asking how the sound effect will start in the slide show. Click “Automatically”
and a sound will appear on the slide.

MS PowerPoint

o Insert a Sound from File

Select the slide you want to have a sound in a normal view.

Click the “Insert” tab.

Click “ Sound from File” and the “Insert Sound” dialog will appear

Find and select your sound file and click “Ok”

To have the sound played whenever the slide is displayed, click “Automatically”.

Click “When Clicked” to have the sound played upon clicking the mouse. This sound will be assigned to
selected slide.

Adding Videos and Photos to Slide Presentation

1.

2.
3.

W

Connect your digital or video camera to your computer or you may insert CD, DVD, flash memory card into
the reader or drive of your computer.

Click “Add Videos and Photos” button in your “Home” tab.

Select the “Library” where your video or photo is located on the “Add Videos and Photos” dialog box.
Here, you may select pictures, documents, and videos from Drive C or removable disk.

Select the picture file.

Click “Open” and the picture will now appear in the preview and storyboard.

In case you want to remove the picture, just right click the picture you want to remove and click “Remove”
on the context menu. To cut, copy, and paste right click the picture you want to remove and click “Cut, Copy
and Paste.”
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Design Transitions Anmimations Slide Show Re

= E |__m | [ I‘—E=| Loy F,__ l . Wl Store

Mew Table  Pictures inlne Screenshot | Phato = Shapes SmartArt Chart 3 My Add

Slide = - Pictures - Album =

Slides Tables Images @| Mew Photo Album... Add-in
i T A

MS PowerPoint

[ K - O - |

Inserting a Video

Select the slide where the video will be enclosed.

Click the “Insert” tab.

Click the “Movie” down arrow in the “Media clips” group.

Click the source of the video file from the pop-up menu.

Look for your video file and insert into the selected slide.

A message will appear asking how to start the movie. Click “Automatically” or “When Clicked”
depending on how you want your movie to start.

7. Double-click the “Video Picture” to preview the video or click the “Slideshow” icon on the view mini

S

toolbar.
8. Select a slide and press F5 to see the complete slide show you have made.
Adding Music

1. Click the “Add Music” on the home tab.
2. Select from the options “Add Music” or “Add Music at the Current Point” and automatically, the music
will be added.

How to Convert PowerPoint Presentation into a Moviemaker
Open MS PowerPoint

Create different slide presentations.

Add music, photos, videos or sounds.

Add animations and transitions to your slide presentation.
Finalize your slide presentation.

Click “File” tab.

Click “Export” in the drop down arrow.

Click “Create a Video”

9. Rename your Moviemaker video.

10. Click “Save”

Activity 1.

Write TRUE if the statement is True and FALSE if the statement is false. Use a separate sheet of paper.
To add music “Click Animation”.

To add Photos or videos click “Add Insert Photo”

Animation effects is used to make the presentation attractive.

Order of animation cannot be changed.

You can have used effect for Animation.

“Custom Animation is used in Microsoft Word.

Microsoft PowerPoint is one of the programs used in creating a multimedia through slide presentation.
Entertainment is a combination of text, video, animated graphics and sound delivered through electronic
means.

9. Inserting Video in MS PowerPoint is not allowed.

10. Inserting sounds can be used in MS PowerPoint.

XN R

A
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Activity 2
Match Column A to column B. Use a separate sheet of paper.
A
1. Edit a. assist in difficulties using presentation of PowerPoint
2. File b. used to view your slides
3. Insert c. checking other presentation that is open
4. View d. commands such as save, save as, and print are found
5. Tools e. undo and redo commands
6. Format f. used to insert new slides
7. Slide shows g. used to change font type, colors, and line spacing
8. Windows h. used when checking of spelling
9. Help 1. combination of text, video and animated graphics
10. Multimedia j. used to see what you have done in slides
Activity 3

Write the correct answer of each picture about MS PowerPoint. Use a separate sheet of paper. (2 points each
correct answer).

1.
¥*: r W W

Appear Fade Fiy In Float In

From From
Beginning Current Slide

T

+ IEEE = B3 [E] E3

Mormal Outline 5Slide MNotes Reading
View Sorter Page View

Fresentation VYWiews

5.

M5 PowerPoint ‘
5. Closure
Try this one!

Note: 1If you have laptop or netbook, desktop or any device which can be used during hands-on activity of

Microsoft PowerPoint, then try this activity. If no device or gadgets just skip this activity.

1. Create a slide presentation that promotes harmonious family relationship. Apply the necessary animation
effects to enhance your presentation.

2. Create a slide presentation using MS PowerPoint about “Me and my Family”. Use pictures or add short
video of your family.

Reference:

Leonora David-Basbas, Ph.D.

Learning and Living in the 21% Century
Answer Key

@ IJTSRD | Unique Paper ID — [JTSRD51735 | Volume—6 | Issue—5 | July-August 2022 Page 1923



